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be subdivided into three domains (Fig. 1a) that perform specific 
and independent functions: the DNA-binding and dimerization 
domain (DBD) containing a Zn2-Cys6 motif that recognizes and 
binds to UAS or QUAS sites; a middle domain (MD) that has no 
clear function but that might be involved in endogenous regula-
tion or stability; and a transcriptional activation domain (AD) 
that recruits molecular machinery necessary for transcription and 
that also binds the Gal80 or QS suppressor.

To overcome limitations of the original QF, any new QF  
variant should be capable of generating healthy transgenic flies 
when broadly expressed. In addition, it should exhibit strong 
transcriptional activity yet remain QS suppressible. We gener-
ated a series of constructs in which certain QF domains were 
modified (Fig. 1a and Supplementary Fig. 1a). In Gal4QF, 
QF2w(eaker) and QFe, the QF AD was mutated to reduce activ-
ity by altering the charge on the C terminus. In QF2, QF2w and 
LexAQF, the QF MD was completely removed; in QFf–i, the  
QF MD was partially removed. Finally, in Gal4QF, LexAQF, QFa–d 
and QFj–l, the QF DBD or QF AD were swapped for analogous 
Gal4 or LexA domains. To quantitatively measure activity levels, 
we performed luciferase assays in cultured Drosophila Schneider 2  
(S2) cells (Fig. 1b). To assay for QF toxicity, we attempted to 
generate transgenic animals expressing each construct under 
the pan-neuronal neuronal Synaptobrevin (nSyb; hereafter, nsyb)  
promoter (Fig. 1, Supplementary Fig. 1 and Supplementary 
Table 1). To allow direct comparison between transgenic con-
structs that use the same enhancer activation sequence (UAS, 
QUAS or LexAop), we used the PhiC31 integrase system and  
targeted all transgenic insertions to the same attP2 genomic 
landing site (3L: 68A4). However, direct comparison between 
transgenic factors using different activation sequences, e.g., UAS 
reporters (Fig. 1c) versus QUAS reporters (Fig. 1d), cannot be 
made owing to differing activities of the reporters.

In relative luciferase activity assays and in vivo expression  
analyses, the optimal QF variants exhibited high activity levels  
(Fig. 1b–f and Supplementary Table 1), were efficiently repressed 
by QS (Supplementary Table 1) and produced healthy trans-
genic animals. We initially hypothesized that a potent QF AD 
may be the source of toxicity as it may be squelching cellular 
transcription factor components16, but QF variants that contained  
the original (QF2 and LexAQF) and mutated AD of QF (QF2w 
and Gal4QF) were not toxic. Instead, constructs containing the 
MD of QF either failed to produce transgenic animals (QFd 
and QFg, Supplementary Fig. 1) or were extremely unhealthy 
(QFf), thereby implicating the QF MD as the major source of QF  
toxicity. Deletion of this domain yielded two smaller QF variants, 
QF2 and QF2w, which exhibited strong but differing QF activities  
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the Q system is a repressible binary expression system for 
transgenic manipulations in living organisms. through protein 
engineering and in vivo functional tests, we report here variants 
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driving strong and ubiquitous expression in all Drosophila 
tissues. our Qf2, Gal4Qf and LexaQf chimeric transcriptional 
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transgenic regulation in Drosophila melanogaster.

The characterization and manipulation of complex biological 
systems require sophisticated genetic tools. Binary expression 
systems are powerful in directing transgenic expression of effec-
tor genes. In Drosophila, the Gal4-UAS1 system has been widely 
adopted, but it has limitations. Existing Gal4 expression patterns 
are often too broad and require refinement, and Gal4-UAS alone is 
insufficient for independent manipulation of two distinct popula-
tions of cells. Two additional binary expression systems have been 
developed: the λ phage LexA-LexAop2 and the Q system, derived 
from the qa gene cluster of the fungus Neurospora crassa3. The  
Q system comprises the transcriptional activator QF, the QF effec-
tor QUAS, the QF suppressor QS and the nontoxic drug quinic 
acid, which inhibits QS. Thus, in addition to QF being repressible 
like Gal4, the Q system has the advantage that expression can be 
temporally regulated by quinic acid.

Despite its immediate application4–8, the original QF was lethal 
when expressed broadly in vivo3, which made it impossible to 
obtain flies that expressed QF under the control of either strong 
pan-neuronal or ubiquitous promoters. The cause of this toxic-
ity was unknown. To address this problem, we aimed to identify 
the region of QF that was responsible for toxicity and to gener-
ate a QF variant that retained full activity yet could be broadly 
expressed with no adverse effects. For our experimental approach, 
we created chimeric proteins between QF, Gal4 and/or LexA2. 
Previous studies9,10, together with our bioinformatic alignments 
of QF and Gal4, predicted that QF is structurally similar to Gal4 
(refs. 11–14). We hypothesized that, like Gal4 (ref. 15), QF can 
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in vitro (2,089 ± 477 s.e.m. and 685 ± 44 s.e.m. times above con-
trol, respectively; P = 0.00064; Kolmogorov-Smirnov test) and 
in vivo (Fig. 1c–e and Supplementary Fig. 1c). Both QF2 and 
QF2w were capable of generating healthy pan-neuronally express-
ing transgenic animals. Thus, the QF MD is dispensable for full 
QF activity, yet it is the major source of QF toxicity in vivo.

We assessed expression patterns and strength of the transac-
tivators at 18 °C, 25 °C and 29 °C with both membrane-tagged 
GFP (Supplementary Fig. 2) and nuclear LacZ reporters  
(Fig. 1f). In findings similar to the in vitro results (Fig. 1b), QF2, 
QF2w, Gal4QF and LexAQF had activity levels comparable to 

that of Gal4 and could be robustly repressed by QS at all tested 
temperatures. In agreement with Mondal et al.17, we found that 
Gal4 activity did not vary with temperature. This contrasts with 
the temperature dependence often observed with many GAL4 
enhancer traps18, which likely reflects the use of temperature-
sensitive elements in these constructs1.

We quantified the expression level for LexABD:QFAD chimeric 
proteins (LexAQF and QFl) with only a GFP reporter (Fig. 1e and 
Supplementary Figs. 1d and 2), as LexAop-nuc-lacZ reporter lines 
were not available. Both constructs drive strong expression in vivo, 
and pan-neuronally expressing transgenic animals were healthy. 
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figure � | Activity of modified QF transcriptional activators in vitro and in vivo. (a) Schematics of Gal4, original QF (ref. 3) and four new transcriptional 
activators. DBD, DNA-binding domain; MD, middle domain; AD, activation domain. Vertical hatching indicates Zn2-Cys6 zinc-finger motifs, diagonal 
hatchings mark dimerization domains. Numbers indicate amino acid position. Constructs are drawn to scale. (b) The transcriptional activity (black) and 
QS repression (gray) of QF transcriptional activators (TA) in S2 cells. Numbers in bars indicate the number of independent repeats. (c–e) Pan-neuronal 
in vivo expression of constructs driven by neuronal Synaptobrevin (nsyb) promoter at 25 °C. Left columns, mCD8-GFP expression in third instar larvae 
(representative of n = 4–6; scale bar, 100 µm); center columns, nuclear LacZ expression in adult Drosophila brain (representative of n = 4–6; scale bar,  
50 µm); right columns, Gal80- or QS-induced suppression of LacZ expression in adult brains (representative of n = 5–7; scale bar, 50 µm). Brains were 
immunostained for elav (red), LacZ (green; βgal, β-galactosidase) and nc82 (blue). (e) Larval and adult expression of mCD8-GFP driven by nsyb-LexAQF 
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©
20

14
 N

at
u

re
 A

m
er

ic
a,

 In
c.

  A
ll 

ri
g

h
ts

 r
es

er
ve

d
.

nature methods  |  ADVANCE ONLINE PUBLICATION  |  �

brief communications

Expression levels of LexAQF-driven GFP were similar to those 
of Gal4-driven GFP at 18 °C, 25 °C and 29 °C (Supplementary 
Fig. 2) and could be repressed by QS at all temperatures  
(data not shown). The LexAQF chimeras offer a useful alter-
native to LexA:VP16 and LexAGal4 transcriptional activators2  
in that LexAQF chimeras are independent of the Gal4-UAS 
system and can be reversibly suppressed by QS (Fig. 1e and 
Supplementary Fig. 1d).

The nuc-lacZ quantification of QS-suppressed activity of QF2 
in vivo (Fig. 1f) suggested that a number of cells were still weakly 
labeled and detectable by our algorithm. To further validate the 
ability of QS to functionally inhibit QF2 and QF2w, we performed 
whole-animal rescue experiments. We drove the expression of the 
temperature-sensitive endocytotic recycling protein encoded by 
shibire (at 29 °C) with nsyb-QF2 or nsyb-QF2w, which did not result 
in surviving adults, as expected. This lethality was fully rescued 
in flies that also carried a tubulin-QS transgene (Supplementary 
Table 2), indicating that QF2 and QF2w are efficiently suppressed  
by QS in vivo. In addition, the activity of all QF AD variants  
(QF2, QF2w, Gal4QF and LexAQF) could be regulated by feeding 
quinic acid to larvae or adult flies (Supplementary Fig. 3). Quinic 
acid had a stronger effect on peripheral receptor neurons than on 
central brain neurons, presumably reflecting differential exposure 
of the neurons to quinic acid.

The new transactivators (QF2, QF2w, Gal4QF and LexAQF), 
together with Gal4, offer the possibility of using Gal4, LexA and 
Q systems simultaneously in overlapping subsets of cells. We veri-
fied that activity of any two of these transactivators in the same 
cells did not result in toxicity or reporter silencing effects by gen-
erating all possible binary combinations of the nsyb transactivator 
flies (Supplementary Fig. 4).

To test whether expression of the new transactivators might 
cause toxicity in non-neuronal tissues, we generated flies that 

express QF2, QF2w, Gal4QF and LexAQF under the control 
of the ubiquitous promoters tubulin (alphaTub84B) and actin 
(act5C). These flies were viable, and activity of the transactiva-
tors was robust in late embryos (data not shown), larvae and 
adult flies (Fig. 2a). These ubiquitous drivers could be effectively 
suppressed by QS in the whole larvae or adult flies (Fig. 2a and 
Supplementary Fig. 5). Examination of imaginal discs (epithelial 
tissue) and larval body walls (muscle) (Supplementary Fig. 5a,b) 
confirmed the broad transactivator expression patterns of QF2, 
QF2w, Gal4QF and LexAQF.

Evidence that Gal4, when driven at very high levels, could be 
toxic to the fly was first found in experiments using the strong 
synthetic eye promoter pGMR19,20. pGMR-QF2w transgenic  
animals exhibited strong QF-induced GFP expression in the eye-
antennal imaginal disc (Fig. 2b), yet they had no morphological 
eye defects at the adult stage. These results suggest that QF2w, 
even when very strongly expressed, was not toxic to the cell.

As a final readout of QF2 and QF2w effects in vivo, we examined 
three different behaviors in flies pan-neuronally expressing QF2, 
QF2w or GAL4 in the same w1118 genetic background (Fig. 3 and 
Supplementary Table 3). Behaviors are a sensitive measure of 
in vivo health: they require key processes, such as development, 
neuronal wiring and neuronal function, to be unaffected. The  
nsyb-QF2 and nsyb-QF2w flies were indistinguishable from 
nsyb-GAL4 controls in olfactory attraction to apple cider vin-
egar and humidified air, but they were slightly but significantly  
(P = 0.0275 and P = 0.0302, respectively) less repelled by CO2 gas 
than the controls (Fig. 3a). nsyb-QF2 and nsyb-QF2w flies exhib-
ited phototactic responses comparable to those of nsyb-GAL4 
flies and wild-type controls (Fig. 3b). In locomotor activity assays  
(Fig. 3c–f), daily activity and daily sleep amounts were 
not significantly different (P > 0.05) between nsyb-QF2,  
nsyb-QF2w and control flies. Both nsyb-QF2 and nsyb-QF2w flies 
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figure 2 | In vivo expression driven by tubulin, 
actin and GMR promoters. (a) Ubiquitous 
expression of GFP or membrane-targeted  
tandem dimer Tomato (mtdT) reporters  
in third instar larvae (left; representative 
of n = 4–6) and in adult flies (right column; 
representative of n = 5). Larvae carry a tubulin 
or actin driver line and an mtdTomato or  
mCD8-GFP reporter as well as a tubP-QS  
transgene where indicated. Adult flies  
(center) are imaged next to the controls 
(left) that bear only the TA or only effector 
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rightmost subpanels (marked by “+tubP-QS”) 
show flies that, in addition to the indicated 
driver and reporter transgenes, also carry  
tubP-QS. Expression of act-LexAQF driver is 
visualized with an mCD8-GFP reporter.  
Imaging settings were identical for all  
images, apart from the duration of exposure, 
which is indicated for each image.  
Scale bars, 1 mm. (b) Scanning electron 
micrographs of the adult female  
eyes (left; representative of n = 10)  
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imaginal disc (right; representative of n = 5)  
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Scale bars, 50 µm.
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exhibited normal circadian rhythms under constant darkness  
(Supplementary Table 3). Taken together, these results  
demonstrate that pan-neuronal expression of QF2 and QF2w is 
compatible with proper neuronal development and function.

In summary, we have developed two next-generation versions 
of QF—QF2 and QF2w—that have dramatically reduced toxicity 
and can be expressed broadly in vivo. QF2 is best suited when 
strong transcriptional activity is required in subsets of cells. QF2w 
is optimal for broad expression patterns or strong promoters. We 
have also developed chimeric Gal4QF and LexAQF transactiva-
tors which, while still activating UAS-geneX and LexAop-geneX 
effectors respectively, are QS suppressible, quinic acid regulat-
able and Gal80-insensitive. These transactivators substantially 
expand the range of possible applications of the Q system by itself 
as well as in combination with Gal4-UAS and LexA-LexAop for  
intersectional targeting.

methods
Methods and any associated references are available in the online 
version of the paper.

Note: Any Supplementary Information and Source Data files are available in the 
online version of the paper.
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figure � | Olfactory, phototaxic, and activity/sleep behavioral  
analyses of heterozygous nsyb-GAL4, nsyb-QF2 and nsyb-QF2w  
transgenic flies. (a) Flies were tested in groups of 50 in a four- 
field olfactometer assay. Control scores are attraction index (AI),  
calculated for the odor quadrant over 5 min preceding presentation  
of an odorant. Odorant scores are AIs calculated for the last 5 min  
of the 10-min odor presentation. We examined a highly  
attractive odor, 5% apple cider vinegar in water; a mildly  
attractive stimulus, pure water; and a repulsive stimulus,  
5% CO2 gas. Numbers in bars indicate number of independent  
experiments for each condition.(b) Visually induced responses  
of two wild-type strains (w– and w+), nsyb-GAL4/+, nsyb-QF2/+  
and nsyb-QF2w/+ were investigated in a ten-step countercurrent  
phototaxis assay (see Online Methods). Phototactic index is the  
average number of approaches to the light that each fly made.  
Numbers in bars indicate number of independent experiments for each condition. (c–f) Daily activity (c), daily sleep time (d), waking activity (e) and 
sleep latency (f) for w– (n = 29 flies), nsyb-GAL4/+ (n = 28), nsyb-QF2/+ (n = 20) and nsyb-QF2w/+ (n = 21) flies, assayed as outlined in the Online 
Methods. Error bars, s.e.m. *P < 0.05, **P < 0.01, ***P < 0.001; as determined by the nonparametric Kolmogorov-Smirnov test. n.s., not significant.
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http://www.nature.com/doifinder/10.1038/nmeth.3250
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http://www.nature.com/reprints/index.html


©
20

14
 N

at
u

re
 A

m
er

ic
a,

 In
c.

  A
ll 

ri
g

h
ts

 r
es

er
ve

d
.

doi:10.1038/nmeth.3250 nature methods

onLine methods
Bioinformatics of QF. Phyre2 (ref. 21) was used for bioinformatic 
prediction of QF secondary protein structures and disordered 
regions to guide domain borders for deletion or chimeric protein 
constructs. The QF dimerization domain at amino acids 115–162 
was predicted based on protein alignments with Gal4 (ref. 22) and 
Phyre2 predictions of a coiled-coil secondary structure. An inter-
nal QF AD was predicted based on protein alignments with Gal4 
and charge plots15 that indicate a negatively charged basic region 
at amino acids 182–206. The QF Zn(II)2Cys6 binuclear DNA-
binding domain at amino acids 75–103 was as predicted in ref. 9. 
The QF AD was predicted as in Wei et al.7. An InterProScan23 of 
QF predicted a conserved fungal transcription factor domain at 
amino acids 372–465, which was the basis for construct QFi.

Toxicity of transgenic QF constructs. Several constructs were gen-
erated as detailed below that failed to produce transgenic animals 
despite multiple attempts (>1,000 embryo injections per construct).

Pan-neuronal Synaptobrevin promoter (nsyb) constructs that 
failed to produce transgenic animals included nsyb-QF in a  
piggyBac transformation vector for random genomic insertions  
(pXL-BACII-nsyb-QF-hsp70) and nsyb-QF in an attB vector 
directed to attP2 (pattB-nsyb-QF-hsp70).

The following pan-tissue constructs that used the tubulin 
promoter (tubP) failed to produce transgenic animals: tubulin 
P-QFcodon_deoptimzed (cdo), in a piggyBac transformation vec-
tor (pXL-BAC-tubulinP-QFcdo); tubulinP-QF::QF2ADweak, in a 
piggyBac transformation vector that contains the same AD mutant 
as in QF2w but with full-length QF (pXL-BAC-tubulinP-QF2M1); 
and tubulinP-QF::QFeAD, in a piggyBac transformation vector 
that contains the same AD mutant as in QFe but with full-length 
QF (pXL-BAC-tubulinP-QF2M2).

Note that nsyb-QFcdo, in a piggyBac transformation vector 
for random genomic insertions, was able to generate transgenic  
animals. Of the ten original lines, induced QUAS-mCD8GFP 
activity was weak, and none of the lines exhibited pan-neuronal  
|expression. In addition, as we were unable to generate  
tubulinP-QFcdo transgenic animals, QFcdo constructs were  
not characterized further.

Our initial hypothesis was that the QF AD was the major source 
of QF toxicity. To circumvent this toxicity when generating QF 
transgenic animals, we injected constructs into flies containing a 
tubP-QS transgenic background. However, this did not help yield 
transgenic animals. Our recent findings suggest this is likely due 
to the MD of QF being the major source of toxicity, which would 
not be attenuated by QS expression. Nonetheless, transgenic 
animals containing the Gal4 binding domain and QF AD (QFb, 
Supplementary Fig. 1) demonstrated the strongest activity of all 
the constructs and were not as healthy as the same QF chimera 
(Gal4QF, Fig. 1) containing the QF2w AD. This suggests that a 
fully potent QF AD might, in some instances, contribute toward  
in vivo toxicity. We note that even Gal4 can be toxic when 
expressed at high levels16,19.

Recombinant DNA construction. Plasmids were constructed 
by standard procedures including enzyme digestions, PCR and 
subcloning. Some of the plasmids were manufactured using 
the In-Fusion HD Cloning System (Clontech, Cat #639645). 
Plasmid inserts were verified by DNA sequencing. Apart from 

the constructs used in the reported experiments, we describe 
four additional constructs (pPT-QF2-hsp70, pattB-DSCP-QF2-
hsp70, pattB-hsp70-QF2-hsp70, pCasper-QF2-hsp70) that may be  
useful for creating new QF2 lines. Primer sequences are shown in 
Supplementary Table 4.

QF codon variants. QFrco, QF recodonized. The original QF 
sequence from Neurospora often yielded tracheal expression 
in enhancer-trap constructs3. This was likely due to a cryptic  
tracheal enhancer in the QF gene sequence. To eliminate this  
tracheal enhancer, the entire coding region of QF was reco-
donized (DNA2.0, Inc.) by manually choosing codons expected 
to yield average expression (http://www.kazusa.or.jp/codon/cgi-
bin/showcodon.cgi?species=7227). Transgenic flies expressing 
QFrco enhancer traps no longer exhibited background tracheal 
expression (data not shown).

QFcdo, QF codon-deoptimized. A Drosophila codon deopti-
mized variant of QF led to reduced expression levels in transgenic  
constructs (data not shown). QFcdo enhancer trap flies induced 
weak reporter activity and also no longer exhibited tracheal 
expression.

Chimeric and deletion cloning strategy. Chimeric constructs 
and deletions were generated by a multistep PCR process using a 
high-fidelity Taq polymerase (Phusion Taq, NEB). PCR fragments 
were generated that had terminal regions of sequence overlap 
(typically 17–25 base pairs to achieve a predicted Tm of 62–65 °C) 
to other PCR fragments. The overlapping PCR fragments were 
used in a second round of PCR in which the overlapping PCR 
fragments each acted as primers for PCR amplification. After 
five cycles, additional oligos were included to selectively amplify 
full-length PCR products. All constructs were sequence verified 
before generating transgenic animals. All pattB-nsyb-geneX-hsp70 
constructs were generated by inserting an EcoRI/AatII digested 
PCR product (Gal4, QFa-QFe, GAL4QF) or In-Fusion compatible 
PCR product (QF2, QF2w, QFf-QFk, LexAQF, LexAG4QF) into 
the EcoRI/AatII site of QF-excised pattB-nsyb-QF-hsp70. Chimera 
construction details are listed in Supplementary Table 5.

S2 cell culture constructs. pAC-QFx (Addgene #46089–46105). 
These plasmids contain QFx variants under the control of the 
actin5c promoter for expression in S2 cell culture. The vector 
backbone for these constructs was obtained by digesting the  
pAC-QF plasmid3 with BamHI and NotI to remove the QF 
gene. New QF variants were PCR amplified from corresponding  
pattB-QFx plasmids and ligated into the vector backbone by an 
In-Fusion reaction. For PCR amplification, the same forward 
primer was used for all QF variants in combination with Gal4 
DNA-binding domain (IF_FOR_GAL4DBD), QF DNA-binding 
domain (IF_FOR_QFDBD) and LexA binding domain (IF_FOR_
LEXADBD) primers. Likewise, the same reverse primer was used 
to PCR-amplify constructs with a Gal4 AD (IF_REV_GAL4AD) 
or an original QF AD (IF_REV_QFAD). Constructs with the LexA 
binding domain were amplified with reverse primer IF_REV_
LEXADBD. The reverse primers for the following were GAL4QF, 
IF_REV_GAL4QF; QF2w, IF_REV_QF2W; QFf, IF_REV_QF_F.

p-LexAop-Luc2. This construct allows expression of the fire-
fly luciferase reporter under the control of LexAop in S2 cell  
culture experiments. The vector backbone was obtained by 

http://www.kazusa.or.jp/codon/cgi-bin/showcodon.cgi?species=7227
http://www.kazusa.or.jp/codon/cgi-bin/showcodon.cgi?species=7227
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cutting pQUAS-luc2 (ref. 3) with HindIII to remove QUAS. 5x 
LexAop was PCR-amplified from pJFRC19-13XLexAop2-IVS-
myr::GFP24 (Addgene Plasmid #26224) with forward primer  
IF_FOR_LexAOP_LUC and reverse primer IF_REV_LexAOP_
LUC, and sub-cloned by an In-Fusion reaction.

Additional constructs used for generating transgenic animals. 
pCasper4-tubP-QF2-hsp70 (Addgene #46127). This construct was 
used to generate fly lines with random genomic insertions of the 
tubulinP-QF2 transgene. The vector backbone was obtained by 
cutting pCasper4-tubP-GAL80 (ref. 25) with NotI and XhoI. 
The QF2-hsp70_terminator insert was PCR amplified from the  
pattB-QF2 plasmid with forward primer IF_FOR_TUB_QF2 and 
reverse primer IF_REV_TUB_QF2, and cloned into the digested 
vector by an In-Fusion reaction.

pCasper-act(B)-QF2w-hsp70. This plasmid was used to gener-
ate fly lines with random genomic insertions of the actin-QF2w 
transgene. Transgenic flies are not described in this paper owing 
to the availability of a stronger ubiquitous driver line, obtained 
with pCasper-tubP-QF2w-hsp70, but are available upon request. 
pCasper-act(B) (DGRC stock#1068) was digested with EcoRI 
and PstI, QF2-hsp70 was PCR amplified from pattB-nsyb-QF2 
with forward primer IF_FOR_ACT_QF2W and reverse primer 
IF_REV_ACT_QF2W and cloned into the digested vector by an 
In-Fusion reaction.

pCasper-tubP-QF2w-hsp70 (Addgene #46128). The 371-bp 
terminus of QF2w was excised from pattB-nsyb-QF2w-hsp70 by 
digestion with NheI/XhoI and cloned into pCasper4-tubulinP-
QF2-hsp70 in which the QF2 C terminus had been excised by 
NheI/XhoI digestion.

pCasper-act-GAL4QF. This construct was used to generate 
transgenic flies with random genomic insertions of the actin-
GAL4QF transgene. pCasper-act(B)-QF2w-hsp70 was digested 
with BamHI and NotI to remove QF2w-hsp70_terminator  
fragment. The GAL4QF-hsp70_terminator fragment was PCR 
amplified from 5-pattB-synaptobrevin-G4BDDM-QFADM1-
hsp70 with the forward primer IF_FOR_ACT_GAL4QF and 
reverse primer IF_REV_ACT_GAL4QF and subcloned into the 
cut pCasper-act vector by an In-Fusion reaction.

pCasper-act-LexAQF. This construct was used to generate 
transgenic flies with random genomic insertions of the actin-
GAL4QF transgene. pCasper-act(B)-QF2w-hsp70 was digested 
with BamHI and NotI to remove QF2w-hsp70_terminator 
fragment. The LexAQF-hsp70_terminator fragment was PCR 
amplified from pattB-synaptobrevin-14-LexA-QF-hsp70 with 
the forward primer IF_FOR_ACT_LEXAQF and reverse primer 
IF_REV_ACT_LEXAQF and subcloned into the cut pCasper-act 
vector by an In-Fusion reaction.

pGMR-QF2w(Addgene #46130). This plasmid was used to gen-
erate random genomic insertions of QF2w, driven by the strong 
GMR eye-specific promoter19,20. Vector pGMR-GAL4 was digested 
with EcoRI to remove the GAL4 gene, and QF2w was PCR ampli-
fied from pAC-QF2w with forward primer IF_FOR_GMR_QF2W 
and reverse primer IF_REV_GMR_QF2W, and subcloned into the 
digested pGMR vector by an In-Fusion reaction.

Additional plasmids generated for QF2. pCasper-act(B)-QF2w-
act_term (Addgene #46126). QF2w was excised from pAC-QF2w 

by digestion with BamHI/NotI and ligated into pCasper4- 
actin5cB-QF2 digested with BamHI/NotI to excise QF2.

pPT-QF2-hsp70 (Addgene #46136). Vector pPTGAL26 was 
digested with PstI, and QF2-hsp70 PCR amplified from pattB-
hsp70-QF2-hsp70 with forward primer IF_FOR_PPT_QF2 and 
reverse primer IF_REV_PPT_QF2 and subcloned into the digested  
vector by an In-Fusion reaction. This construct contains a min-
imal hsp70 promoter and allows for convenient subcloning of 
enhancers upstream of QF2.

pattB-DSCP-QF2-hsp70 (Addgene #46133). The pattb-QF-
hsp70 plasmid3 and pattb-syb-QF2 were both cut with EcoRI and 
ZraI, and the isolated QF2 insert was ligated into the digested  
pattb-hsp70 vector using the Rapid DNA Ligation Kit (Roche). 
The pattb-QF2-hsp70 plasmid was digested with EcoRI and 
BamHI, and the DSCP promoter PCR amplified from pattB- 
DSCP-QF-SV40 (ref. 3) with forward primer IF_FOR_DSCP_QF2 
and reverse primer IF_REV_DSCP_QF2, and cloned into the 
digest vector by an In-Fusion reaction. This PhiC31 integrase 
compatible plasmid utilizes the DSCP promoter27 to allow for the 
cloning of enhancer regions to drive QF2 expression.

pattB-hsp70P-QF2-hsp70T (Addgene #46134). The pattb-QF2-
hsp70 plasmid was digested with EcoRI and BamHI, and the hsp70 
promoter PCR amplified from pUAST1 with forward primer IF_
FOR_ATTB_QF2 and reverse primer IF_REV_ATTB_QF2, and 
subcloned into the digested vector by an In-Fusion reaction. This 
PhiC31 integrase compatible plasmid utilizes the hsp70 minimal 
promoter to allow for the cloning of enhancer regions to drive 
QF2 expression.

pCasper-act(B)-QF2-act_term (Addgene #46125). QF2 was PCR 
amplified from pattB-nsyb-QF2 using oligos IF-FOR-pCasper-
ActB-QF7 and IF-REV-pCaspActB-QF7 and In-Fusion (Clontech) 
cloned into pCasper-act(B) digested with BamHI.

pCasper4-QF2-hsp70 (Addgene #46135). The QF2-hsp70  
cassette was PCR amplified from pattB-nsyb-QF2-hsp70 to include 
flanking XbaI restriction sites and inserted into the XbaI site of 
pCasper4 (DGRC stock# 1213).

Progenitor plasmids for constructs described in this paper. 
pattB-synaptobrevin-QFcdo-hsp70. The Synaptobrevin promoter 
was PCR amplified from pattB-nsyb-DSCP-QF-SV40 to include 
flanking BamHI and EcoRI restriction sites. The tubulin promoter 
from pattB-tubulinP-QFcdo-hsp70 was excised by digestion with 
BamHI/EcoRI and replaced with the digested n-Synaptobrevin 
PCR product.

pattB-nsyb-DSCP-QF-SV40. The n-Synaptobrevin promoter 
was PCR amplified from the plasmid pPTGAL4+n-syb (a vector 
containing the n-Synaptobrevin promoter upstream of the CMV 
minimal promoter, kindly provided by J. Simpson, Janelia Farm 
Research Campus) to include flanking EcoRI restriction sites. The 
EcoRI digested PCR product was ligated into the EcoRI restric-
tion site of pattB-DSCP-QF3.

pattB-tubulinP-QFcdo-hsp70. The hsp70 terminator from pXN-
QF-hsp70 was PCR amplified to include AscI/NotI restriction sites 
(hsp70-AscI-FOR, hsp70-NotI-REV) and ligated into the pattB-
tubulinP-QFcdo-SV40 vector digested with AscI/NotI to excise 
the SV40 terminator.

pattB-tubulinP-QFcdo-SV40. QFcdo was excised from p35030-
QFcdo (synthesized by DNA2.0) by digestion with EcoRI/AscI  
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and replaced by ligation the QF in plasmid pattB-tubulinP-
QF+AscI digested with EcoRI/AscI.

pattB-tubulinP-QF+AscI. The tubulin promoter from pCasper-
tubulinP-GAL80 (ref. 25) was excised by digestion with BamHI/
EcoRI and ligated into the BamHI/EcoRI site of the pattB-QF+AscI 
plasmid.

pattB-QF+AscI. An AscI restriction site between QF and the 
SV40 terminator was introduced into pattB-QF-SV40 (ref. 3) by 
digestion with AatII and ligation of a compatible sticky-ended 
annealed dsDNA of target sequence TGGCGCGCCA.

pattB-synaptobrevin-QF-hsp70. The n-Synaptobrevin promoter 
was PCR amplified from pattB-nsyb-QF-SV40 to include BamHI 
and EcoRI restriction sites and ligated into the BamHI/EcoRI 
multiple-cloning site of pattB-QF-hsp70 (ref. 3).

pattB-tubulinP-QFrco-hsp70. The QFcdo-hsp70 fragment from 
pattB-tubP-QFcdo-hsp70 was excised by EcoRI/XhoI digestion 
and replaced with an EcoRI/XhoI QFrco-hsp70 cassette digested 
from pXL-BAC-attP-Ppromoter-QFrco-hsp70.

pXL-BAC-attP-Promoter-QFrco-hsp70. pJ241-QFrco (synthe-
sized by DNA2.0) was digested with SnaBI/BglII to excise QFrco 
and ligated into the SnaBI/BglII site of pXL-BAC-LoxP-DsRed-
LoxP-attP-Promoter-QF-hsp70 in which QF had been excised by 
digestion with SnaBI/BglII.

pXL-BAC-tubulinP-QFrco-M1(EQ->KK). The C terminus of 
QFrco was mutated by PCR-amplifying QFrco from pXL-BAC-
tubulinP-QFrco-hsp70 using primers QFrco-NheI-FOR, QFrcoM1-
REV, digestion with NheI/BglII and ligation into NheI/BglII 
digested pXL-BAC-tubulinP-QFrco-hsp70.

pXL-BAC-tubulin-QFrco-M2(E->K). The C terminus of QFrco 
was mutated by PCR-amplifying QFrco from pXL-BAC-tubulinP-
QFrco-hsp70 using primers QFrco-NheI-FOR, QFrcoM2-REV, 
digestion with NheI/BglII and ligation into NheI/BglII digested 
pXL-BAC-tubulinP-QFrco-hsp70.

Drosophila genetics. Flies were kept on a standard fly medium 
with a 12:12 h light/dark (LD) cycle in a 25 °C incubator, unless 
indicated otherwise. UAS, QUAS and LexAop reporter lines were 
obtained from the Bloomington Drosophila Stock Center (NIH 
P40OD018537). Reporter transgenes were integrated at various 
genomic positions, but where possible, we used the same reporter 
line with new transactivator driver lines to compare activation 
strengths. Standard procedures were used to generate transgenic 
Drosophila either by P-element or piggyBac transgenesis or by 
PhiC31 integration3.

Quinic acid experiments. To investigate the effect of quinic acid 
(QA), we used 2- to 3-d female flies of one of the following geno-
types: (i) tub-QS/+; nsyb-QF2, QUAS-mCD8:GFP/+, (ii) tub-QS/+; 
nsyb-QF2w, QUAS-mCD8:GFP/+, (iii) tub-QS/+; nsyb-GAL4QF, 
UAS-mCD8:GFP/+ or (iv) tub-QS/+; nsyb-LexAQF, LexAop-IVS-
myr:GFP/+.

These flies were raised on standard fly medium until they 
were 2- to 3-d-old adults, at which point they were transferred 
into vials containing 10 ml of 1% agarose (Denville Scientific, 
Cat #CA3510-8) supplemented with 0.1 g of sucrose (Sigma,  
Cat #S0389) and 0.6 g of QA (Sigma, Cat #138622). The vials also 
contained yeast paste made from dry yeast and QA solution (3 g 
of QA per 10 ml of H2O, neutralized to pH 6.5 by 10 mM NaOH 
solution). The same QA solution was used to moisten a Kimwipe 

that was embedded into the agarose gel. Flies were kept in these 
QA-containing vials for 3 d, after which brains were dissected and 
immunostained as described below.

S2 cell transfections and luciferase assays. S2 cells (Life 
Technologies, Cat #R690-07) were cultured in Express Five SFM 
(serum-free medium, Gibco, Cat #10486-025), supplemented 
with 18 mM l-glutamine (Gibco, Cat #25030-081) and penicillin/
streptomycin/l-glutamine mixture (25,000 units/25,000 µg/ 
200 mM, Lonza, Cat #17-718R, 4.5 ml per 1 liter of SFM). The 
cells were maintained in 75-cm2 tissue culture flasks (Sarstedt, 
Cat #83.1811.002) at room temperature and atmospheric CO2, 
and passaged every 4–6 d for no more than 26 generations. 
Cells were tested for mycoplasma infection by a PCR reaction 
using primers specific to 16S mycoplasma ribosomal RNA cod-
ing regions. For transfections, 0.3 ml per well of cell-containing 
medium and 0.3 ml per well of fresh medium were placed into 
24-well plates (Corning, Cat #3524) 24 h before transfection. 
All transfections were performed using Effectene Transfection 
Reagent (Qiagen, Cat #301425). 200 ng of DNA (per well) were 
mixed with Effectene reagent, enhancer and buffer according to 
manufacturer’s instructions, supplemented with 0.4 ml (per well) 
of fresh medium and carefully pipetted into the wells. For QFx  
activity assays, each well was transfected with 12.5 ng of a trans-
cription factor pAC-QFx plasmid, 50 ng of firefly luciferase reporter 
plasmid (pLexAop-luc2, pQUAS-luc2, or pUAS-luc2), 50 ng  
of Renilla luciferase plasmid (pAC-hRluc) for normalization and 
87.5 ng of pBluescript (pBS-KS) plasmid. In the controls, 12.5 ng 
of the transcription factor plasmid were replaced by 12.5 ng of 
pBluescript. We always transfected one of the wells in each 24-well 
plate with 200 ng of pBluescript and left one well untransfected for 
control purposes. For QS repression assays, 87.5 ng of pBluescript 
were replaced by 87.5 ng of pAC-QS plasmid and cotransfected 
with pAC-QFx, firefly and Renilla luciferase plasmids. Controls 
for QS assays were the same as for QF activity assays (firefly and 
Renilla reporters and pBluescript plasmid). Cells were lysed 48 h 
after transfection by replacing the medium in the wells with 0.1 ml  
of passive lysis buffer (PLB) from the Dual Luciferase Reporter 
Assay System (Promega, Cat #E1980) and shaking the plates at 
room temperature for 10 min. For luciferase activity measure-
ments, the original lysates were diluted 10,000 times in PLB and 
analyzed by a Fluorostar Optima (BMG Labtech) plate reader 
immediately after lysing. Each lysate sample was placed into three 
different wells in a 96-well plate; from each well the luminescence 
was measured automatically six times (once per second) after 
the addition of firefly luciferase substrate and six times (once per  
second) after the addition of Renilla luciferase substrate. The  
relative luminescence (RL) of each well was calculated as

RL
Firefly_measurement

_measurement
= −

−

3 6

3 6Renilla

where X-  is the average luminescence signal in response to luci-
ferase X substrate. The average was calculated for measurements 
3–6 because the first two measurements were often substantially 
different from the following four. To obtain the relative luciferase 
activity (RLA, Fig. 1b), the RL was averaged between the three wells 
that contained the same lysate. Next, this average RL, calculated  
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for wells with transcription factor, was divided by a control  
RL, obtained from a corresponding control wells (only reporter 
plasmids without transcription factor).

RLA
RL

RL
transcription_factor

no_transcription_factor
=

For example, for pAC-GAL4 plasmid

RLA
RL
RL

Firefly_measurement

Gal4
pAC Gal4

pUAS luc2

pAC G

= =

− −

−

−

3 6, aal4

pAC Gal4_measurement
Firefly_measurement
Renilla 3 6

3 6

− −

−

,

,ppUAS luc2

pUAS luc2_measurement
−

− −Renilla 3 6,

and for pAC-QF plasmid

RLA
RL

RL

Firefly_measurement

QF
pAC-QF

pQUAS-luc2

pAC QF

= =

− −3 6,
Rennilla_measurement

Firefly_measurement
pAC QF

pQUAS l

3 6

3 6

− −

− −

,

, uuc2

pQUAS luc2_measurementRenilla 3 6− −,

Thus, one RLA measurement was obtained for each of the wells 
from the original 24-well plate that contained a transcription  
factor plasmid. Figure 1b shows the results of four or five RLA 
measurements for each construct, apart from pAC-QF2w, which 
was measured ten times. Each RLA measurement was obtained 
from independent transfections performed on different days.

Immunohistochemistry. Dissection of larval imaginal discs and 
adult brains, immunostaining and confocal imaging were done  
as described previously28. In short, brains of third instar larvae or 
4- to 5-d-old adult flies were dissected in PBS, fixed for 20 min at 
room temperature, washed at room temperature in PBT for 5–6 h, 
blocked in 5% NGS in PBT and placed in primary antibody mixes 
for three nights at 4 °C. Next, the brains were washed for several 
hours in PBT at room temperature and placed in secondary anti-
bodies mix for two nights at 4 °C. The following day the brains 
were washed in PBT and placed in mounting solution (Slow Fade 
Gold) overnight at 4 °C, and mounted on a microscope slide the 
next day. To visualize GFP expression, we used rabbit anti-GFP 
(Life Technologies #A11122, 1:100), chicken anti-GFP (Aves Labs 
Inc., #GFP1020, 1:250) and mouse nc82 (DSHB, 1:25; not used 
for larval brains) primary antibodies; for LacZ experiments we 
used preabsorbed rabbit anti–β-galactosidase (MP Biomedicals 
#08559762, 1:50), Rat-ELAV-7E8A10 anti-ELAV (DSHB, 1:50)  
and mouse nc82 (1:25) primary antibodies; to visualize  
mtdT-3HA, we used rat anti-HA (Roche #11867423001) primary 
antibody (1:100). Secondary antibodies used for GFP expression were  
Alexa 488 anti-rabbit (Invitrogen #A11034, 1:200) and Cy3 anti-
mouse (Jackson ImmunoResearch #115-165-062, 1:200). For 
LacZ experiments: Cy3 anti-rabbit (Jackson ImmunoResearch 
#111-165-144, 1:200), 633 anti-rat (Invitrogen #A21094, 
1:200) and Alexa 488 anti-mouse (Invitrogen #A11029, 1:200).  

For mtdT-3HA experiments: Cy3 anti-rat (Jackson 
ImmunoResearch #112-165-167, 1:200). Larval imaginal discs 
were stained in DAPI (1:100) for 10 min during one of the  
PBT washes after secondary antibody incubation.

Whole-animal imaging. Third instar larvae were placed on 
a small metal plate on top of crushed ice or on a temperature-
controlled plate and imaged by a Zeiss SteREO DiscoveryV8 
microscope equipped with a GFP-470 and ds-Red filters and a 
Jenoptik ProgRes MF cool CCD camera. Monochrome images 
were acquired in ProgRes Mac Capture Pro 2.7 software and 
stored in .tif format. Adult flies (3–5 d old) were anesthetized  
on a CO2 pad and imaged as described for larvae. Images that are 
compared to each other were obtained under identical hardware 
and software settings.

Confocal imaging and image processing. Brains were imaged  
on an LSM 700 Zeiss confocal microscope equipped with a LCI 
Plan-Neofluar 25×/0.8 Imm Korr DIC M27 water-immersion 
objective, at 512 × 512 pixel resolution, with 1-µm or 2.37-µm 
z steps. See Supplementary Note for details. Zen 2012 Release 
Version 8 software was used for image acquisition. Microscope 
settings were kept the same for the genotypes that were later  
compared to each other, i.e., all nsyb-QFx/(Q)UAS-mcd8-GFP 
brains, all nsyb-QFx/(Q)UAS-nucLacZ brains, etc.

For illustration purposes, confocal images were processed in 
ImageJ to collapse z stacks into a single image using maximum-
intensity projection and to pseudocolor different acquisition 
channels using an RGB Merge plug-in. No other image process-
ing was performed on the confocal data.

To quantify LacZ expression, we used a custom-written Matlab 
(MathWorks) script. The script (Fig. 1f) identified cells in the elav 
channel and used the outlines of these cells as a mask to select 
the corresponding pixels in the LacZ channel. Then it calculated 
the average intensity of these pixels in the LacZ channel and nor-
malized it by the average intensity of initially selected elav cells. 
The algorithm for identifying cells was adapted from a script by  
T. Kuo and J. Buyn (Center for Bioimage Informatics, also used in 
ref. 3). The cells were identified for every image in a z stack, and 
the intensity measures of each image were averaged to produce 
one number per brain.

To quantify GFP expression (Supplementary Fig. 2), we identi-
fied pixels with above-threshold intensity in the GFP channel on 
each image of a z stack. Next, we calculated the average intensity 
of the identified pixels, producing one number per imaged brain. 
Finally, we averaged the intensity measures of separate brains.

Scanning electron microscopy imaging. Heads of 3- to  
5-d-old female flies were mounted without any processing onto  
aluminum stubs with double-stick carbon tape (Ted Pella) or  
Blu-Tack (Bostik). Images were acquired at 200× magnification 
with a Leo 1530 field emission scanning electron microscope 
operating at 1 kV.

Behavioral tests. All flies used in behavioral tests were outcrossed 
to the same wild-type isoD1 white– background for five genera-
tions. Control and experimental data sets were compared using 
the nonparametric Kolmogorov-Smirnov test.
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Phototactic behavior. Experiments were conducted in a  
photography dark room using overhead infrared lights for  
illumination. The F15T8/WW fluorescent lamp light source was 
switched off during control experiments. 50 male and 50 female 
5-d-old flies were used for each experiment. Prior to the assay, 
flies were kept in vials with regular fly medium at room tempera-
ture. The experimental setup was as described previously29 and 
consisted of 21 cell culture tubes (14 ml, BD Falcon, REF 352059), 
arranged in two rows of 10 and 11 tubes so that the open ends of 
the tubes were facing each other. For example, tube 0 was opposite 
tube 0′, tube 1 was opposite tube 1′ and so on. Flies were initially 
placed in tube 0 and given 2 min to walk toward the light source 
and into tube 0′. Next, tube 0′ was shifted into register with tube 1,  
the flies were tapped down from tube 0′ into tube 1 and again 
given 2 min to walk toward the light and into tube 1′ and so on. 
In total, each fly had ten chances to walk toward the light source 
in the course on an experiment. The phototaxis index (PI) was 
calculated as

PI PI=
∗
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=

∑
∑

i N

N

ii

ii

0
10

0
10 0 10, [ ; ]

where Ni is the number of flies in tube i at the end of the exper-
iment. PI equals to the average number of times a fly walked 
toward the light source, with a PI = 10 indicating that all flies 
always walked toward the light and PI = 0 meaning that no flies 
walked toward the light. We repeated the experiment and the 
lights-off control 4–7 times for each genotype. Figure 3b repre-
sents the data as an average PI for each genotype and experimental 
condition; error bars show s.e.m.

Activity and sleep assays. For activity/sleep measurements, flies 
were outcrossed five times into iso31 background (Bloomington 
#5905). Flies were entrained to a 12:12 h LD cycle for at least 2 d 
before being assayed. Flies were kept in glass tubes containing 5% 
sucrose and 2% agar, and monitored using the Drosophila Activity 
Monitoring System (Trikinetics). Activity counts from 4- to  
7-d-old female flies were collected in 1-min bins in the LD cycle at  
25 °C for 2 d. Activity/sleep parameters were computed using  
Matlab-based custom software. Sleep was identified as peri-
ods of inactivity lasting at least 5 min. For circadian behavior  
measurement, activity counts were recorded in 30-min bins in 
constant darkness over a 6-d period and analyzed using ClockLab 
(Actimetrics). Period length (τ) was determined by χ2 periodo-
gram analysis, and rhythm strength was measured by relative FFT, 
calculated by fast Fourier transform analysis.

Olfactory behaviors in the four-field assay. These olfactory 
experiments were conducted as described previously30. The 
experimental setup consisted of a temperature-controlled light-
proof chamber (45 cm × 27 cm × 49 cm) that was equipped with 
four air inlets, a CCD camera (Sony CCD IR XC-E150 with 
Pentax 12.5mm 1:1.4 TV lens) and two arrays of infrared LEDs. 
The chamber was designed to accommodate a rectangular arena  
(23 cm × 23 cm × 3 cm), the corners of which could be connected 
to the four air inlets. The arena consisted of a Teflon base sand-
wiched between two glass plates. The bottom glass plate had a 
hole (diameter = 6 mm) in the middle to let out the air that was 

pumped into the arena from the corners. The arena was placed 
horizontally inside the chamber and filmed by a CCD camera 
from above. The video data were acquired at 30 f.p.s., 640 × 480 
pixels, by a custom-written GUI. Immediately after acquisition, 
the data were processed by custom-written Matlab scripts and 
stored as a .mat file. The data structure contained information 
about coordinates of each detected fly at each point in time, and 
also about trajectories of individual flies, whenever the trajecto-
ries could be resolved unequivocally.

25 female and 25 male flies were starved for 41–43 h before 
each experiment and were 5 d old when tested. The flies were 
transferred without anesthesia into the four-field arena that was 
immediately placed into the experimental setup and flushed with 
clean dry air (DA) at 0.1 l/min from each corner for 20 min.  
We recorded the flies’ activity for 10 min in DA and for the  
following 10 min with 5% CO2, water vapor, or 5% apple cider 
vinegar in water blown into one quadrant of the arena. Three 
other quadrants were flushed with DA at all times. Experiments 
were conducted in the dark, at 25 °C maintained in the experi-
mental chamber. Flies’ activities were quantified as an attraction 
index (AI) calculated for the odorant quadrant. The 10-min DA 
recording served as a control for the odor experiment. If the flies’ 
activity was too low or they were distributed unevenly in the arena 
(|AI|>0.15) during the 10-min DA recording, this group of flies 
was not tested with an odorant. The AI was calculated as

AI AI [odorant DA

odorant DA
= −

+
∈ −N N

N N
, ; ]1 1

where Nodorant is the number of data points in the odorant quad-
rant during 10 min, and NDA is the average number of data 
points in the other three quadrants that were always flushed 
with DA. Each walking fly generated 30 data points per second.  
A fly was deemed stationary if its speed was consistently below  
4.5 pixel/s for 3.3 s. The data points from stationary flies were 
discarded. AI = −1 corresponds to complete repulsion from the 
odor quadrant, and AI = 1 corresponds to complete attraction 
toward the odor quadrant.

Code availability. Custom-written Matlab scripts, used for  
quantifying confocal imaging data and for behavioral analyses, 
are available upon request.

Reproducibility. Our sample size (Fig. 3) is similar to that  
normally used in the literature for these kinds of experiments. 
No data were excluded from the analysis. No randomization was 
used, and no blinding was used.
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Supplementary Figure 1 

In vitro and in vivo activities of additional QF variants.  
This figure characterises the additional QF variants generated to find the region responsible for QF toxicity. 

Some variants yielded insufficient transcriptional activity (QFa,c,e,g-k), some were either lethal in vivo (QFd), or 

exhibited substantial (QFf) or slight (QFb) in vivo toxicity. QFl is an efficient and non-toxic LexAQF chimera, but 

since a smaller and stronger alternative exists (LexAQF, Fig. 1) that showed similar activity, QFl was not 

characterized further. (a) Schematics of GAL4, QF and twelve experimental transcriptional activators. BD, DNA 

binding domain; MD, middle domain; AD, activation domain. Vertical hatching indicates Zn2-Cys6 zinc finger 

motifs, diagonal hatchings mark dimerization domains. Numbers indicate amino acid position. Constructs are 

drawn to the same scale. Construct QFb is structurally identical to GAL4QF (Fig. 1), apart from 4 amino acid 

changes in the C-terminus of the protein (see Online Methods). Construct QFe was made by replacing the C-

terminal 22 amino acids of QF with four lysines. This change also likely affected the QS binding site. (b) The 

transcriptional activity (black bars) of QF variants were investigated by transfecting S2 cells with actin-QFX 

plasmid, firefly luciferase reporter plasmid (pLexAop-luc2, pQUAS-luc2 or pUAS-luc2), Renilla luciferase 

plasmid (pAC-hRluc) for normalization, and pBluescript (pBS-KS) plasmid for loading control. For QS repression 

assays (grey bars), Bluescript plasmid was replaced with pAC-QS plasmid and co-transfected together with 

actin-QFX, firefly and Renilla luciferase plasmids. QForig is the original Neurospora QF codon sequence from 

Ref.. QF in this table, and for all variants, has been re-codonized to yield average Drosophila expression levels 

(see Online methods). Numbers in bars indicate the number of independent repeats. Error bars are SEM. 

Luciferase activity is shown on a log scale. (c) Pan-neuronal in vivo expression of constructs driven by neuronal 

synaptobrevin (nsyb) promoter at 25 ˚C. Left column shows mCD8-GFP expression in third-instar larvae (scale 

bar, 100 µm), middle column shows mCD8-GFP expression in adult brain (nc82, magenta; GFP, green; scale 

bar, 50 µm), and the right column nuclear lacZ expression in adult brains (elav, red; lacZ, green; nc82, blue). (d)

Larval and adult expression of LexAop-mCD8:GFP, driven by the nsyb-QFl construct. Right panel, tub-QS 

suppression of QFl activity. (e) Quantification of LacZ expression (see Online Methods). Numbers in bars 

indicate the number of brains for each condition. Error bars are SEM. 
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Supplementary Figure 2 

Quantification of GFP expression driven by nSyb lines at 18 °C, 25 °C and 29 °C. 
This experiment is analogous to the one shown in Fig. 1f, but instead of nuclearLacZ reporter, we used a 

membrane-bound GFP reporter (n=5 for all conditions). Flies were reared at the indicated temperature from 

embryonic stage until 4 days post-eclosion. This experiment allows us to investigate the possible variability of 

expression levels due to the nature of the reporter transgene. See Online Methods for details of 

quantification procedure. 
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Supplementary Figure 3 

Quinic acid–induced disinhibition of expression. 
(a) Third instar larvae that express GFP pan-neuronally (left) have GFP expression suppressed by tub-QS 

(middle) and this suppression is inhibited by raising animals in standard fly medium supplemented by 0.1 g of 

quinic acid (QA) per 10 ml of food (right). All larvae are imaged at the same settings. Genotypes are indicated 

below corresponding images. Scale bar, 0.3 mm. (b) Brains of adult flies were immunostained for nc82 

(magenta) and GFP (green) and imaged at the same confocal settings. To observe the effect of feeding QA to 

adult flies, flies were raised to adulthood on standard fly medium and transferred for 3 days into vials that 

contained 0.6 g of quinic acid (QA, see Online Methods for details). Scale bar, 50 µm. 
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Supplementary Figure 4 

Coexpression of nsyb transactivator driver lines results in viable flies that exhibit robust transgene 

expression. 
Shown are brains of flies that carry two nsyb driver lines, one of which drives pan-neuronal expression of 

nuclear lacZ (red), and the other drives independent pan-neuronal expression of a membrane-bound GFP 

(green). Brains are counter-stained with nc82 (blue). nsyb-QF2 and nsyb-QF2
w

 lines both drive expression of 

QUAS effectors, making it impossible to use these two drivers independently in the same cell. The same 

applies for nsyb-GAL4 and nsyb-GAL4QF lines which both activate UAS effectors. All tested binary 

combinations yielded healthy animals, suggesting that at least two independent binary systems can be 

simultaneously utilized in neuronal tissues. Scale bar, 50 µm. 
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Supplementary Figure 5 

Activity of ubiquitously driven QF2, QF2
w

, GAL4QF and LexAQF in non-neuronal tissue. 
(a) Expression patterns of actin-GAL4QF, tubulin-QF2 and tubulin-QF2

w
, visualised with a UAS/QUAS-nuclacZ 

reporter and compared to expression patterns of direct driver tub-nucLacZ (Bloomington stock #29726), actin-

GAL4 (Bloomington stock #3954), and tubulin-GAL4 (Bloomington stock #5138). We did not investigate the 

activity of actin-LexAQF in the same way due to the unavailability of a LexAop-nuclacZ reporter. Tubulin-

nucLacZ expression serves as a control for binary system independent expression achievable by the tubulin 

promoter. Scale bar, 50 µm. (b) Expression patterns represented by ubiquitous GALQF, QF2, QF2
w

 and LexAQF 

activity in larval body wall muscles. Each driver line was crossed to a corresponding strong hexameric mCherry 

reporter, as indicated on the figure panel. Third-instar larvae were dissected using the "larval fillet" 

preparation and imaged directly, without immunostaining, under identical illumination and image acquisition 

parameters for 150 ms. Wild-type control larvae were imaged for 1000 ms and produced no discernible image. 

Scale bar, 300 µm. (c) Expression and QS-mediated repression of GALQF, QF2, QF2
w

 and LexAQF activity in 

larval imaginal discs. Discs from larva that carried a driver and a reporter line (actin-GAL4QF + 5xUAS-mtdt-

3HA, actin-LexAQF + 13xLexAop2-6xmcherry-HA, tubulin-QF2 + 5xQUAS-mtdt-3HA or tubulin-QF2
w

 + 5xQUAS-

mtdt-3HA) are shown in columns 1, 3, 5 and 7, correspondingly. Columns to the right of these (2, 4, 6 and 8) 

show imaginal discs from larvae that also carried a tubulin-QS transgene. All discs were immunostained for the 

HA epitope and counterstained with DAPI using the same protocol (see Online Methods). Weak residual signal 

in actin-LexAQF + 13xLexAop2-6xmcherry-HA+tub-QS (fourth column) is observed in peripodial membrane 

cells. Scale bar, 50 µm. 
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Supplementary Note 
 
Equipment and settings 

• Fig. 1c-d, Supplementary Fig. 1b (right column), confocal images of adult fly brains: 
Image size: x: 512 px, y: 512 px, z: 74 images, channels: 3, 8-bit 
Dimensions: x: 319.46 µm, y: 319.46 µm, z: 172.73 µm 
Fluorochromes: Alexa488 goat @ mouse, imaged with a 488 nm laser 
  Cy3 goat @ rabbit, imaged with a 555 nm laser 
  633 goat @ rat, imaged with a 639 nm laser 
Images were processed in ImageJ as follows: 
  Image-> Color-> Split channels 

Plugins -> Biorad ->GJ RGB Merge (pseudocolor as follows: Alexa488 -> 
blue channel, Cy3 ->green channel, 633 -> red channel) 
Make one image: Image -> Stacks-> Z-project (maximum intensity 
projection) 
File -> Save as -> Tiff 

The figure was assembled in Adobe Illustrator, where the size of the *.tiff file was reduced as 
required. 

• Fig. 1e, Supplementary Fig. 1b (middle column), Supplementary Fig. 1d, Supplementary 
Fig. 3b, confocal images of adult fly brains: 
Image size: x: 512 px, y: 512 px, z: 74 images, channels: 2, 8-bit 
Dimensions: x: 319.46 µm, y: 319.46 µm, z: 172.73 µm 
Fluorochromes: Alexa488 goat @ rabbit, imaged with a 488 nm laser 
  Cy3 goat @ mouse, imaged with a 555 nm laser 
Images were processed in ImageJ as follows: 
  Image-> Color-> Split channels 

Plugins -> Biorad ->GJ RGB Merge (pseudocolor as follows: Alexa488 -> 
green channel, Cy3 ->blue channel and red channel) 
Make one image: Image -> Stacks-> Z-project (maximum intensity 
projection) 
File -> Save as -> Tiff 

The figure was assembled in Adobe Illustrator, where the size of the *.tiff file was reduced as 
required. 

• Fig. 1c-e, Fig. 2a, Supplementary Fig. 3a, Supplementary Fig. 5b, wide-field images of 
third instar larvae: 
Image size: x: 680 px; y: 512 px, 8 bit 
Dimensions: x: 2 mm; y: 1.5 mm 
Images were acquired as described in Online Methods ("Whole-animal imaging") and 
cropped/reduced in size as required in Adobe Photoshop and Adobe Illustrator. 

• Fig 2a, wide-filed images of adult flies: 
Image size: x: 680 px; y: 512 px, 8 bit 
Dimensions: x: 7.2 mm; y: 5.4 mm 
Images were acquired as described in Online Methods ("Whole-animal imaging") and 
cropped/reduced in size as required in Adobe Photoshop and Adobe Illustrator. 

• Fig 2b, SEM images of fly eye: 
Image size: x: 1024 px; y: 768 px, 8 bit 
Dimensions: x: 565 µm; y: 400 µm 
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Images were acquired as described in Online Methods ("Scanning electron microscopy 
imaging") and cropped/reduced in size as required in Adobe Photoshop and Adobe Illustrator. 

• Fig. 2b, Supplementary Fig. 5a, confocal images of eye-antennal imaginal discs: 
Image size: x: 512 px, y: 512 px, z: 42 images, channels: 2, 8-bit 
Dimensions: x: 511 µm, y: 511 µm, z: 41 µm 
Fluorochromes: Alexa488 goat @ rabbit, imaged with a 488 nm laser 
  DAPI, imaged with a 405 nm laser 
Images were processed in ImageJ as follows: 
  Image-> Color-> Split channels 

Plugins -> Biorad ->GJ RGB Merge (pseudocolor as follows: Alexa488 -> 
green channel, DAPI ->blue channel) 
Make one image: Image -> Stacks-> Z-project (maximum intensity 
projection) 
File -> Save as -> Tiff 

The figure was assembled in Adobe Illustrator, where the size of the *.tiff file was reduced as 
required. 

• Supplementary Fig. 4, confocal images of adult fly brains: 
Image size: x: 512 px, y: 512 px, z: 74 images, channels: 3, 8-bit 
Dimensions: x: 319.46 µm, y: 319.46 µm, z: 172.73 µm 
Fluorochromes: Alexa488 goat @ chicken (top row) or rat (middle and bottom row), imaged 

with a 488 nm laser 
  Cy3 goat @ mouse, imaged with a 555 nm laser 
  633 goat @ rabbit, imaged with a 639 nm laser 
Images were processed in ImageJ as follows: 
  Image-> Color-> Split channels 

Plugins -> Biorad ->GJ RGB Merge (pseudocolor as follows: Cy3 -> blue 
channel, Alexa488 ->green channel, 633 -> red channel) 
Make one image: Image -> Stacks-> Z-project (maximum intensity 
projection) 
Increase brightness: Image -> Adjust -> Brightness/Contrast 
File -> Save as -> Tiff 

The figure was assembled in Adobe Illustrator, where the size of the *.tiff file was reduced as 
required. 

• Supplementary Fig. 5c, confocal images of eye-antennal imaginal discs: 
Image size: x: 512 px, y: 512 px, z: 42 images, channels: 2, 8-bit 
Dimensions: x: 511 µm, y: 511 µm, z: 41 µm 
Fluorochromes: Cy3 goat @ rat, imaged with a 555 nm laser 
  DAPI, imaged with a 405 nm laser 
Images were processed in ImageJ as follows: 
  Image-> Color-> Split channels 

Plugins -> Biorad ->GJ RGB Merge (pseudocolor as follows: Cy3 -> red 
channel, DAPI ->blue channel) 
Make one image: Image -> Stacks-> Z-project (maximum intensity 
projection) 
File -> Save as -> Tiff 

The figure was assembled in Adobe Illustrator, where the size of the *.tiff file was reduced as 
required. 
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Supplementary Tables 
 
Supplementary Table 1. Activity levels of QF variants in vitro.  
 
The data in this Table is graphically presented in Fig. 1 and Supplementary Fig. 1. Each 
average value was calculated from 4-10 independent repeats. QS suppression is calculated as 
the ratio of average values for Relative Luciferase activity and Relative QS-suppressed 
activity. QForig is the original Neurospora QF codon sequence from Reference #3. QF in this 
table, and for all variants, has been re-codonized to yield average Drosophila expression 
levels (see Online methods). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Relative	  
Luciferase	  activity	  

Relative	  QS-‐
suppressed	  
activity	  

QF	  
variant	  

	   mean	   SEM	   mean	   SEM	  

QS	  
suppression,	  

fold	  

GAL4 1595.00	   778.70	   1072.09	   196.50	   	   1.49	   	  
QForig 1935.53	   775.90	   6.47	   1.25	   	   299.08	   	  
QF 1754.09	   549.40	   19.72	   3.92	   	   88.93	   	  
GAL4QF 2208.21	   927.37	   2.13	   0.32	   	   1037.79	   	  
QF2 2089.33	   477.67	   19.51	   2.51	   	   107.10	   	  
QF2w 685.06	   44.19	   2.62	   0.29	   	   261.50	   	  
LexAQF 944.72	   138.53	   4.55	   0.49	   	   207.77	   	  
QFa 285.41	   79.48	   112.83	   22.58	   	   2.53	   	  
QFb 3554.81	   1669.77	   4.67	   1.04	   	   760.60	   	  
QFc 122.52	   45.75	   102.64	   13.97	   	   1.19	   	  
QFd 872.95	   271.51	   512.41	   48.45	   	   1.70	   	  
QFe 234.17	   81.81	   63.62	   4.97	   	   3.68	   	  
QFf 2417.78	   668.80	   49.14	   5.47	   	   49.20	   	  
QFg 15.67	   4.34	   1.00	   0.06	   	   15.60	   	  
QFh 1.29	   0.08	   1.01	   0.04	   	   1.27	   	  
QFi 1.37	   0.12	   1.19	   0.05	   	   1.14	   	  
QFj 1.17	   0.09	   1.11	   0.04	   	   1.05	   	  
QFk 1.30	   0.09	   1.06	   0.06	   	   1.23	   	  
QFl 685.35	   44.52	   2.02	   0.20	   	   338.82	   	  
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Supplementary Table 2. Functional rescue experiments by tub-QS.  
 
These experiments serve as a functional test of the effectiveness of QS-induced suppression. 
Flies that pan-neuronally expressed temperature-sensitive shibire do not survive to adulthood 
when raised at 29˚C. Survival is completely restored in the presence of tub-QS. These 
experiments indicate that QS efficiently inhibits the transcriptional activity of QF2 and QF2w 
in vivo. 
 

Genotype Flies of listed 
genotype collected 

(% of total progeny) 

Flies of listed genotype 
expected if survival was 

not affected  
(% of total progeny) 

nsyb-QF2, QUAS-nuclacZ/QUAS-shits (raised at 
29C) 

0 (0%) 130 (33%) 

tub-QS/+; nsyb-QF2, QUAS-nuclacZ/QUAS-shits 
(raised at 29C) 

76 (48%) 78 (50%) 

   
nsyb-QF2w, QUAS-nuclacZ/QUAS-shits (raised at 
29C) 

0 (0%) 31 (33%) 

tub-QS/+; nsyb-QF2w, QUAS-nuclacZ/QUAS-shits 
(raised at 29C) 

35 (51%) 34 (50%) 
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Supplementary Table 3. Circadian rhythm phenotypes of nsyb-QF2 and nsyb-QF2w 
compared to nsyb-Gal4 and background control flies. 

 
nsyb-QF2/+ and nsyb-QF2w/+ flies exhibited normal circadian rhythms under constant 
darkness.  Period length (tau) in these flies was similar to nsyb-Gal4/+ and background 
control flies, and rhythm strength (as measured by FFT) was intact in all flies. 
 

Genotype # of flies % rhythmic tau ± SEM Relative FFT ± SEM 
w- 29 100% 23.6±0.11 0.24±0.01 

nsyb-Gal4/+ 28 100% 23.6±0.06 0.17±0.01 
nsyb-QF2/+ 20 100% 23.7±0.12 0.18±0.01 
nsyb-QF2w/+ 21 100% 23.7±0.06 0.20±0.02 
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Supplementary Table 4. Primers, used in this study. 

Name Sequence 
RI-G4BD-FOR TTTAGAATTCCAACATGAAGCTACTGTCTTCTATCGAACAAGC 
QF-G4DM-FOR ATAAGAGCATTACCCGCCTCCTCATTGACTCGGCAGCTCATCATG 
QF-G4AD-FOR ACACTGGTCTGCAGCCAATTCCACTGACCCCGTCTGCTTTG 
QF-G4BD-REV GAGCGGCTTGGCCCGACGATACAGTCAACTGTCTTTGACCTTTG 
QF-G4DM-REV GTAGGAGGGAGCTCCAACTGACGCACTAATGATTGCAGCTGTTGCTG 
AATII-G4AD-REV TATAAGACGTCTATTACTCTTTTTTTGGGTTTGGTGGG 
QFrcoM1-REV  TTATAGATCTTCACTTTTTGTATGTATTAATGTCGGAGAAGTTACATCCAGG 
QFrcoM2-REV TTATAGATCTTCACTGTTTGTATGTATTAATGTCGGAGAAGTTACATCCAGG 
QFrco_Nhe_FOR GCCATGGTTGACGATTTGGC 
RI-QFBD-FOR GAAGCTAGAGAATTCCAACATGCCAC 
G4-QFDM-FOR GGTCAAAGACAGTTGACTGTATCGTCGGGCCAAGCCGCTC 
G4-QFAD-FOR CAACAGCTGCAATCATTAGTGCCGTCAGTTGGAGCTCCCTCCTAC 
G4-QFBD-REV CATGATGAGCTGCCGAGTCAATGAGGAGGCGGGTAATGCTCTTATTG 
G4-QFDM-REV CAAAGCAGACGGGGTCAGTGGAATTGGCTGCAGACCAGTGTTTG 
AATII-QFAD-REV TATTTGACGTCATCACTGTTCGTATGTATTAATGTCGGAGAAG 
AATII-QFADM2-REV TATTTGACGTCTACTACTTTTTCTTTGGGTCGACATCCACAGCG 
AATII-QFADM1-REV TATTTGACGTCATCATTTCTTCTTTTTGTATGTATTAATGTCGGAGAAGTTACATC 
IF_QFBD_FOR TCGACAGCCGAATTCCAACATGCCACCCAAGC 
IF_QFAD_REV CGACGGTATCGATAGACGTCATCACTGTTCGTATGTATTAATG 
IF_QFAD_QFBD_REV GAGCTCCAACTGACGGAGGAGGCGGGTAATGC 
IF_QFBD_QFAD_FOR ATTACCCGCCTCCTCCGTCAGTTGGAGCTCCCTC 
IF_QFAD_QFAD_REV GAGCTCCAACTGACGATCTTGAACATTGATATCCTCCG 
IF_QFAD_QFAD_FOR ATCAATGTTCAAGATCGTCAGTTGGAGCTCCCTC 
IF_QFAD_QFMD_REV GAGCTCCAACTGACGCAAACCTTCGCAGGGG 
IF_QFMD_QFAD_FOR CCCTGCGAAGGTTTGCGTCAGTTGGAGCTCCCTC 
IF_QFMD475_QFBD_REV GTGCTCTCCTCCCAAGAGGAGGCGGGTAATGC 
IF_QFBD_QFMD_FOR ATTACCCGCCTCCTCTTGGGAGGAGAGCACACAATG 
11L_QF262MD_QFBD_REV CGCCAGTGGTTAGGAGGCAGGAGGAGGCGGGTAATGC 
11M_QFBD_QF262MD_FOR CAATAAGAGCATTACCCGCCTCCTCCTGCCTCCTAACCACTGGC 
11M-QFAD_QFMD475_REV GTAGGAGGGAGCTCCAACTGACGCAAACCTTCGCAGGGGG 
11R_QF475MD_QFAD_FOR GACCCCCTGCGAAGGTTTGCGTCAGTTGGAGCTCCCTC 
12L_G4MD50_QFBD_REV TCCACTTCTGTCAGATGTGCCCTAGTAACTCCCCTCTTTTTCGGC 
12M_QFBD_G4MD50_FOR TCGCCGAAAAAGAGGGGAGTTACTAGGGCACATCTGACAGAAGTG 
12M_13M_QFAD_G4MD_REV GTAGGAGGGAGCTCCAACTGACGGGTCAGTGGCACTAATGATTGC 
12R_G4MD_QFAD_FOR CTGCAATCATTAGTGCCACTGACCCGTCAGTTGGAGCTCCCTC 
13L_G4MD_QFAD_REV GCGTCGGTGAGTGCACGATCTTTCCTATTCCAGTGCCATC 
13M_QFAD_G4MD_FOR CGGATGGCACTGGAATAGGAAAGATCGTGCACTCACCGACG 
14L_QFAD_LEXBD_REV GTAGGAGGGAGCTCCAACTGACGTCCCAGCCAATCTCCG 
14R_LEXBD_QFAD_FOR CAACGGAGATTGGCTGGGACGTCAGTTGGAGCTCCCTC 
15L_QFAD_G4MD_REV GTAGGAGGGAGCTCCAACTGACGCGTAAGTGGCACCAGACTCTG 
15R_G4LXMD_QFAD_FOR GCAGAGTCTGGTGCCACTTACGCGTCAGTTGGAGCTCCCTC 
IF_FOR_GAL4DBD CAGAGACCCCGGATCCAACATGAAGCTACTGTCTTCTATCGAAC 
IF_FOR_QFDBD CAGAGACCCCGGATCCAACATGCCACCCAAGCG 
IF_FOR_LEXADBD CAGAGACCCCGGATCGAATTCCAAAATGCCACCCAAGAAG 
IF_REV_GAL4AD TCGGTTAACGCGGCCTTCCTCTTTTTTTGGGTTTGGTGGG 
IF_REV_QFAD TCGGTTAACGCGGCCTCACTGTTCGTATGTATTAATGTCGGAG 
IF_REV_LEXADBD TCGGTTAACGCGGCCGACGTCATCACTGTTCGTATGTATTAATGTC 
IF_REV_GAL4QF TCGGTTAACGCGGCCTCATTTCTTCTTTTTGTATGTATTAATGTCGG 
IF_REV_QF2W TCGGTTAACGCGGCCGCTCATTTCTTCTTTTTGTATGTATTAATGTCGGAGAAGTTAC 
IF_REV_QF_F TCGGTTAACGCGGCCCTACTTTTTCTTTGGGTCGACATCC 
IF_FOR_LexAOP_LUC ACCTGAGCTCGCTAGGCTAGCGCATGCCTGAGG 
IF_REV_LexAOP_LUC ATTCGATATCAAGCTGACGTCACTAGTGCTAGAGTCTCCGCTTAC 
IF_FOR_TUB_QF2 ATCAGATCCGCGGCCCAACATGCCACCCAAGCG 
IF_REV_TUB_QF2 GCAGGTCGACCTCGAGGATCTAAACGAGTTTTTAAGCAAACTCAC 
IF_FOR_ACT_QF2W CAGAGACCCCGGATCCAACATGCCACCC 
IF_REV_ACT_QF2W CATGGTCGACGGATCGCGGCCGCTCACTGTTCGTATGTATTAATGTCG 
IF_FOR_ACT_GAL4QF CAGAGACCCCGGATCCAACATGAAGCTACTGTCTTCTATC 
IF_REV_ACT_GAL4QF CGACGGATCGCGGCCGCTCATTTCTTCTTTTTGTATGTATTAATG 
IF_FOR_ACT_LEXAQF CAGAGACCCCGGATCCAAAATGCCACCCAAGAAGAAG 
IF_REV_ACT_LEXAQF CGACGGATCGCGGCCGCTCACTGTTCGTATGTATTAATGTCGGAG 
IF_FOR_GMR_QF2W TCTGAATAGGGAATTCAACATGCCACCC 
IF_REV_GMR_QF2W ATCTGTTAACGAATTCTCATTTCTTCTTTTTGTATGTATTAATG 
IF_FOR_PPT_QF2 ACAAGCTAAACAATCTGCAGGAATTCCAACATGCCACCCAAG 
IF_REV_PPT_QF2 ACGCAAAGCTTGGGCTGCAGTCTAGAGGTACCCTCGAGCCGCGGCCGC 
IF_FOR_DSCP_QF2 TTATGCTAGCGGATCCGAGCTCGCCCGGGGATCG 
IF_REV_DSCP_QF2 TGGCATGTTGGAATTCGTTTGGTATGCGTCTTGTGATTCAAAGTTGG 
IF_FOR_ATTB_QF2 TTATGCTAGCGGATCCGAGCGCCGGAGTATAAATAGAGGC 
IF_REV_ATTB_QF2 TGGCATGTTGGAATTCGAGAGTTCTCTTCTTGTATTCAATAATTACTTCTTGG 
IF-FOR-pCasper-ActB-QF7 CAGAGACCCCGGATCCAACATGCCACCC 
IF-REV-pCaspActB-QF7 CATGGTCGACGGATCGCGGCCGCTCACTGTTCGTATGTATTAATGTCG 
hsp70-AscI-FOR AAATGGCGCGCCTATCGATACCGTCGACTAAAGCC 
hsp70-NotI-REV CCTAGGCATGCTTAATTAAGGCGGC 
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Supplementary Table 5. Details of PCR conditions for generating chimeric constructs. 
 
Construct PCR template DNA PCR primers (see Supplementary Table 4) * 
pattB-synaptobrevin-
GAL4-hsp70 (GAL4) 
(Addgene#46107) 

pGAWB1 RI-G4BD-FOR 
AATII-G4AD-REV 

pattB-synaptobrevin-1-
QFBDAD-G4DM-hsp70 
(QFa) (Addgene#46109) 
 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pGAWB 
PCR fragment 3: pattB-
tubP-QFrco 

PCR fragment 1: RI-QFBD-FOR, G4-QFDB-REV 
PCR fragment 2: QF-G4DM-FOR, QF-GFDM-REV 
PCR fragment 3: G4-QFAD-FOR, AAtII-QFAD-REV 
Full length product: RI-QFDB-FOR, AatII-QFAD-REV 
 

pattB-synaptobrevin-2-
G4BDDM-QFAD-hsp70 
(QFb) (Addgene#46110) 

PCR fragment 1: pGAWB 
PCR fragment 2: pattB-
tubP-QFrco 

PCR fragment 1: RI-G4BD-FOR, QF-G4DM-REV 
PCR fragment 2: G4-QFAD-FOR, AatII-QFAD-REV 
Full length product: RI-G4BD-FOR, AatII-QFAD-REV 
 

pattB-synaptobrevin-3-
QFBD-G4DMAD-hsp70 
(QFc) (Addgene#46111) 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pGAWB 

PCR fragment 1: RI-QFBD-FOR, G4-QFBD-REV 
PCR fragment 2: QF-G4DM-FOR, AatII-G4AD-REV 
Full length product: RI-QFBD-FOR, AatII-G4AD-REV 
 

pattB-synaptobrevin-4-
QFBDDM-G4AD-hsp70 
(QFd) (Addgene#46112) 

PCR fragment 1: pGAWB 
PCR fragment 2: pattB-
tubP-QFrco 

PCR fragment 1: QF-G4AD-FOR, AatII-G4AD-REV 
PCR fragment 2: RI-QFBD-FOR, G4-QFDM-REV 
Full length product: RI-QFBD-FOR, AatII-G4AD-REV 
 

pattB-synaptobrevin-5-
G4BDDM-QFADM1-
hsp70 (GAL4QF) 
(Addgene#46113) 

PCR fragment 1: pGAWB 
PCR fragment 2: pattB-
tubP-QFrcoM1 

PCR fragment 1: RI-G4BD-FOR, QF-G4DM-REV 
PCR fragment 2: G4-QFAD-FOR, AatII-QFADM1-REV 
Full length product: RI-G4BD-FOR, AatII-QFADM1-REV 
 

pattB-synaptobrevin-6-
G4BDDM-QFADM2-
hsp70 (QFe) 
(Addgene#46114) 

PCR fragment 1: pGAWB 
PCR fragment 2; pattB-
tubP-QFrco 

PCR fragment 1: RI-G4BD-FOR, QF-G4DM-REV  
PCR fragment 2: G4-QFAD-FOR, AatII-QFADM2-REV 
Full length products RI-G4BD-FOR, AatII-QFADM2-REV 
 

pattB-synaptobrevin-7-
QFBDAD-hsp70 (QF2) 
(Addgene#46115) 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pattB-
tubP-QFrco 

PCR fragment 1: IF-QFBD-FOR, IF-QFAD-QFBD-REV  
PCR fragment 2: IF-QFBD-QFAD-FOR, IF-QFAD-REV 
Full length product: IF-QFBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-8-
QFAD184-214-hsp70 
(QFf) (Addgene#46117) 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pattB-
tubP-QFrco 

PCR fragment 1: IF-QFBD-FOR, IF-QFAD-QFAD-REV  
PCR fragment 2: IF-QFAD-QFAD-FOR, IF-QFAD-REV 
Full length product: IF-QFBD-FOR, IF-QFAD-REV 
 

pattB-synaptobrevin-9-
QFMD184-475-hsp70 
(QFg) (Addgene#46118) 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pattB-
tubP-QFrco 
 

PCR fragment 1: IF-QFBD-FOR, IF-QFAD-QFMD-REV  
PCR fragment 2: IF-QFMD-QFAD-FOR, IF-QFAD-REV 
Full length product: IF-QFBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-
10-QFMD475-650-
hsp70 (QFh) 
(Addgene#46119) 
 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pattB-
tubP-QFrco 

PCR fragment 1: IF-QFBD-FOR, IF-QFMD475-QFBD-REV  
PCR fragment 2: IF-QFBD-QFMD-FOR, IF-QFAD-REV 
Full length product: IF-QFBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-
11-QFMD262-475-
hsp70 (QFi) 
(Addgene#46120) 
 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pattB-
tubP-QFrco 
PCR fragment 3: pattB-
tubP-QFrco 

PCR fragment 1: IF-QFBD-FOR, 11L_QF262MD_QFBD_REV 
PCR fragment 2: 11M_QFBD_QF262MD_FOR, 11M-
QFAD_QFMD475_REV 
PCR fragment 3: 11R_QF475MD_QFAD_FOR, IF-QFAD-REV  
Full length product: IF-QFBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-
12-QFBDAD-G4DM50-
761-hsp70 (QFj) 
(Addgene#46121) 
 

PCR fragment 1: pattB-
tubP-QFrco 
PCR fragment 2: pGaWB 
PCR fragment 3: pattB-
tubP-QFrco 

PCR fragment 1: IF-QFBD-FOR, 12L-G4MD50-QFBD-REV  
PCR fragment 2: 12M-QFBD-G4MD50-FOR, 12M_13M-QFAD-
G4MD-REV 
PCR fragment 3: 12R-G4MD-QFAD-FOR, IF-QFAD-REV  
Full length product: IF-QFBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-
13-QFBDAD-
G4MD257-761-hsp70 
(QFk) (Addgene#46122) 
 

PCR fragment 1: pattB-
tubP-QFrc 
PCR fragment 2: pGaWB 
PCR fragment 3: pattB-
tubP-QFrco 

PCR fragment 1: IF-QFBD-FOR, 13L-G4MD-QFAD-REV  
PCR fragment 2: 13M-QFAD-G4MD-FOR, 12M_13M-QFAD-
G4MD-REV 
PCR fragment 3: 13R-G4MD-QFAD-FOR, IF-QFAD-REV  
Full length product: IF-QFBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-
14-LexA-QF-hsp70 
(LexAQF) 

PCR fragment 1: 
pBPnlsLexA::GADflUw24 
(Addgene#26232) 

PCR fragment 1: IF-LEXBD-FOR, 14L-QFAD-LEXBD-REV  
PCR fragment 2: 14R-LEXBD-QFAD-FOR, IF-QFAD-REV 
Full length product: IF-LEXBD-FOR, IF-QFAD-REV 
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(Addgene#46123) 
 

PCR fragment 2: pattB-
tubP-QFrco 

pattB-synaptobrevin-
15-LexABD-G4MD-
QFAD-hsp70 
(LexAG4QF) 
(Addgene#46124) 

PCR fragment 1: 
pBPnlsLexA::GADflUw 
PCR fragment 2: pattB-
tubP-QFrco 

PCR fragment 1: IF-LEXBD-FOR, 15L-QFAD-G4MD-REV  
PCR fragment 2: 15R-G4LXMD-QFAD-FOR, IF-QFAD-REV 
Full length product: IF-LEXBD-FOR, IF-QFAD-REV 

pattB-synaptobrevin-
QF2w-hsp70 (QF2w) 
(Addgene#46116) 

pAC-QF2w RI-QFBD-FOR, AatII-QFADM1-REV 

* For PCR reactions with 2 fragments, PCR fragments 1 and 2 were incubated in a PCR reaction for 5 cycles and 
external oligos included for another 25 cycles. For PCR reactions with 3 fragments, PCR fragments 1 and 2 were 
incubated in a PCR reaction for 5 cycles, and in a separate PCR reaction, PCR fragments 2 and 3 were incubated together 
for 5 cycles. These two separate reactions were then mixed, cycled 5 times, and external oligos included for another 25 
cycles.  
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